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1 Introduction

1.1 Overview

MQTT Message Editing Suite (MMES) application allows users to subscribe, publish, edit, copy, 
delete, forward, backup, restore, import and export messages of a topic of an MQTT Broker. 

The messages of a topic are presented in a table format similar to a spreadsheet program. MMES is an 
MQTT (MQ Telemetry Transport) client that connects to an MQTT Broker. MQTT is a machine-to-
machine (M2M)/Internet of Things (IoT) connectivity protocol. MMES supports MQTT protocol 
versions 3.1, 3.1.1 and 5.0.

MMES is an excellent tool for IoT (Internet of Things) application programmers, developers, quality 
assurance testers, and production support personnel. The tool allows for quick problem solving 
because the data is presented in a very logical and insightful manner.

MMES can connect to any remote MQTT Broker. The remote MQTT Broker can be on any platform. 
The following is a sample of the MQTT Brokers that MMES can connect to: 2lemetry, Apache 
ActiveMQ, Apache Apollo, EMQ, GnatMQ, HBMQTT, HiveMQ, IBM MessageSight, IBM MQ, 
JoramMQ, Moquette, Mosquitto, MQTT.js, RabbitMQ, RSMB, Software AG Universal Messaging, 
Solace, ThingMQ and VerneMQ.

An MQTT Broker is responsible for receiving all messages, filtering the messages, deciding which 
clients are interested in the messages and then sending them to all subscribed clients.

MMES has full language support for the following 55 languages: Amharic, Arabic, Azerbaijani, 
Bengali, Cebuano, Chinese (Mandarin China), Chinese (Mandarin Taiwan), Czech, Danish, Dutch, 
English, Finnish, French, German, Greek, Gujarati, Hausa, Hebrew, Hindi, Hungarian, Igbo, 
Indonesian, Italian, Japanese, Javanese, Kannada, Korean, Malay, Malayalam, Marathi, Norwegian, 
Panjabi, Pashto, Persian, Polish, Portuguese, Romanian, Russian, Shona, Sindhi, Spanish, Sundanese, 
Swahili, Swedish, Tamil, Telugu, Thai, Turkish, Ukrainian, Urdu, Uzbek, Vietnamese, Xhosa, Yoruba 
and Zulu.

MMES supports SSL/TLS.

MMES is designed to run on a desktop platform. This includes: Linux x86 64-bit, macOS (Mac OS X),
Windows 7/8/8.1/10 and Raspberry Pi (ARM).
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1.2 Prerequisites
This section provides the minimum supported software levels.

1.2.1 Java
MQTT Message Editing Suite requires Java 8 or higher.

1.2.2 MQTT
MQTT Message Editing Suite requires MQTT v3.1 or higher.  i.e. v3.1, v3.1.1 or v5.0

1.2.3 Operating System
MQTT Message Editing Suite is capable of running on the following operating system platforms that 
support Java SE 7 (or higher):

 Windows 7/8/8.1/10
 Linux x86 64-bit (Desktop)
 macOS (Mac OS X) 10.8 or higher
 Raspberry Pi (ARM)
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2 Installing MQTT Message Editing Suite
This chapter will describe the installation and registration of MQTT Message Editing Suite.

2.1 Installation

2.1.1 Windows Installation

To install MQTT Message Editing Suite on Windows, do the following instructions:

• Run the install program called: mmes-setup-withjre.exe
• The installer follows the standard Windows install procedures and provides default values for 

the user.
• When the install program has completed execution, there will be a newly created folder under 

Start -> All Programs called MQTT Message Editing Suite. 
• To run MQTT Message Editing Suite, select the MQTT Message Editing Suite icon from 

within the MQTT Message Editing Suite folder. 

2.1.2 Linux Installation

To install MQTT Message Editing Suite on Linux x86 64-bit, do the following instructions:

• First, the user needs to set the 'execute' permission for the installer program:

chmod +x mmes-setup-linux.bin

• Next, run the installer with the following command:

./mmes-setup-linux.bin

• The installer will prompt the user for the installation directory.  The default value will be 
'Capitalware/MMES/'.

• To run MQTT Message Editing Suite, go to the installation directory and issue the following 
command:

./mmes
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2.1.3 macOS Installation
To install MQTT Message Editing Suite on macOS, do the following:

• Double click the MQTT_Message_Editing_Suite.dmg file to open it
• Follow the instructions on the opened DMG window and drag the MQTT Message Editing 

Suite icon to the Applications folder.
• Close the DMG window and then eject the DMG
• To run MQTT Message Editing Suite, go to the Application folder and double click on MQTT 

Message Editing Suite

2.1.4 Raspberry Pi Installation
To install MQTT Message Editing Suite on Raspberry Pi, do the following:

1. ftp or copy the selected mmes-RaspberryPi.tar.zip file to the target platform
2. Unzip the mmes-RaspberryPi.tar.zip to an appropriate directory with the following commands:

unzip mmes-RaspberryPi.tar.zip
tar -xvf mmes-RaspberryPi.tar

3. Change directory to Capitalware/MMES/
4. To run MQTT Message Editing Suite, go to the installation directory and issue the following 

command:

./mmes
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2.2 Registration
This section will describe how to obtain a license and then register your copy of MQTT Message 
Editing Suite.  To purchase a copy of MQTT Message Editing Suite (obtain a license), go to 
Capitalware's web site (www.capitalware.com) and select MQTT Message Editing Suite, then click the
Buy Now button.

A license is for a single end-user.  Once the user has received their license key, they will need to input 
the license key in the Registration window and then retrieve an Access Code.  Note: A license key can
ONLY be registered once.  When the user clicks the Submit button MQTT Message Editing Suite will 
attempt the register the user's license key by contacting the 'capitalware.com' server.

Note: Do not register MQTT Message Editing Suite under 
Administrator account or any other SysAdmin account.  It must be
the end-user who completes the registration process under their 
own account.

If your company uses a Proxy Server then the user will need to input this information, so that MQTT 
Message Editing Suite can access the internet.  Select File then Preferences: 

Click Enable Proxy Server checkbox then input your company's Proxy Server and Proxy Port and 
click OK to save the information.
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To input the license key, from the main menu of MMES, select File then Register:

Do the following:
• Input the user's name and email address
• Next, click the Yes button to input your license key

• Finally, click the Submit button to get your Access Code.

Note: A license key can ONLY be registered once.
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2.3 Connectivity Issues
This section will describe how to handle registering MQTT Message Editing Suite when the user has 
connectivity issues.

2.3.1 Registering using a Web Browser
Before attempting to register via a web browser, please attempt the instructions in section 2.2 (clicking 
the Submit button).  If you followed the instructions in section 2.2 including setting the Proxy values 
and the registration failed then the end-user can attempt to register via a web browser

Click the Web Browser button to  launch the default web browser on your PC/laptop.

MQTT Message Editing Suite will launch the default web browser on your PC/laptop and then display 
the following popup.
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Your web browser will connect to Capitalware’s online registration server and submit the end-user’s 
information for registering the product.  When the registration process is complete, the web browser 
will display your Access Code.  En email will also be sent to the email address that the end-user 
provided. 

Next, click Add button

Copy and paste the Access Code from the web browser (or email) and then click OK button
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2.3.2 Registering by Email

Before attempting to register via an email, please attempt the instructions in section 2.2 (clicking the 
Submit button) and the instructions in section 2.3.1.  If you followed the instructions in section 2.2 
including setting the Proxy values and the registration failed then the end-user can attempt to register 
via a web browser

If MQTT Message Editing Suite cannot make a connection to Capitalware's web server (with or 
without a Proxy Server) or the default web browser cannot make a connection, then the user can email 
the information to 'support@capitalware.com'.  Click the OK button to retrieve the information:

MQTT Message Editing Suite will launch the default email client program on your PC/laptop and 
create the following email which is to be sent to 'support@capitalware.com'.

You will receive the Access Code via email.  Simply click the Add button and input the Access Code.  
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When you receive the reply email from Capitalware Support, do the following:

Click Add button

Copy and paste the Access Code from the reply email and then click OK button.

MQTT Message Editing Suite User's Guide                                                                                          Page 10



2.4 A New or Replacement PC or Laptop
This section will describe how to handle inputting your information into MQTT Message Editing Suite
for a new/replacement PC/laptop after you have previously registered your MQTT Message Editing 
Suite license key.

It is very common for users to get a new PC/laptop or have Windows re-installed on their PC/laptop.  
The first thing the user needs to do is find the email called 'MQTT Message Editing Suite Access 
Code' from 'support@capitalware.com' that they received when they originally registered MQTT 
Message Editing Suite.  It will contain their Access Code.

• First, the user needs install MQTT Message Editing Suite (follow the installation instructions in
section 2.1).

• Optional step, the user will want to copy the following 2 files to their new PC/laptop that are 
located in C:\Users\{UserId}\Capitalware\ directory:
◦ BrokerInfo.db
◦ UserFormats.db  (if it exists)

• Finally, the user will need to input their information, License Key and Access Code into MQTT
Message Editing Suite
◦ Click File -> Register and input your name and email address
◦ Click the Yes button and input the License key
◦ Click Add button and input your Access Code from the email the user previously received
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2.5 Yearly Registration Process
MQTT Message Editing Suite license is for a 1-year subscription.  When the 1-year subscription ends, 
the license key becomes invalid (garbage).  Hence, to continue to use MQTT Message Editing Suite, 
the end-user will need to purchase another license for a 1-year subscription to MQTT Message Editing 
Suite.  This section will describe how to register a new license key during or after an existing 1-year 
subscription to MQTT Message Editing Suite.

If the end-user is using a previous release of MQTT Message Editing Suite, Capitalware strongly 
suggests that the end-user upgrades to the latest release of MQTT Message Editing Suite.   The order 
email includes the download link (with UserId and Password) to the latest commercial release of 
MQTT Message Editing Suite.  Simply follow the upgrade instructions in Appendix B.

To input the license key, from the main menu of MQTT Message Editing Suite, select File then 
Register.

Do the following:

• Click the Yes button to input your license key

• Input the new license key and then click the OK button
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• Next, click the Submit button to get your Access Code.

Note: A license key can ONLY be registered once.
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2.6 Enterprise License File
This section will describe how to handle the storing of an Enterprise License file.  

Note: This section is only applicable to those customers who have purchased an Enterprise License for 
MQTT Message Editing Suite.

Upon the purchase or renewal of an Enterprise License for MQTT Message Editing Suite, the customer
will be emailed both the Enterprise License key and the Enterprise License file.    Enterprise License 
file is called 'mmes.license.properties'.  Do not rename the Enterprise License file or modify its 
contents.

MQTT Message Editing Suite is supported on Windows, macOS and Linux.  The Enterprise License 
file is designed to be deployed to any and all of those platforms.

MQTT Message Editing Suite will look for the Enterprise License file in 1 of 3 directories:

1. The user’s settings directory '{home directory}\Capitalware\' :
◦ On Windows:  C:\Users\{UserId}\Capitalware\
◦ On macOS:     /Users/{UserId}/Capitalware/
◦ On Linux:       /home/{UserId}/Capitalware/

2. The user’s '{home directory}\' :
◦ On Windows:  C:\Users\{UserId}\
◦ On macOS:     /Users/{UserId}/
◦ On Linux:       /home/{UserId}/

3. The MQTT Message Editing Suite install directory:
◦ On Windows:  C:\Users\{UserId}\Capitalware\MMES\
◦ On macOS:      not applicable
◦ On Linux:        /apps/Capitalware/MMES/

Capitalware recommends putting the Enterprise License file in the user’s settings directory (option #1).
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3 Managing Groups
This chapter will describe how to add, rename and delete a Group.

3.1 Adding a Group
This section will describe how to add a Group to MQTT Message Editing Suite.  A Group will hold 1 
or more MQTT Broker Profiles.  The Group name can be any name the user wishes.

From the main menu of MQTT Message Editing Suite, select File then Add Group...:

After the user inputs a name, click the OK button to create the new group.

3.2 Renaming a Group
This section will describe how to rename a Group in MQTT Message Editing Suite.

In the MQTT Brokers' dock, right click on the group name to be renamed, then select Rename 
Group…:

Input a new group name then click the OK button:
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3.3 Deleting a Group
This section will describe how to delete a Group from MQTT Message Editing Suite.  

Note: If the user deletes a group containing MQTT Broker Profiles then when the group is deleted, 
those MQTT Broker Profiles will be moved to the default group called '[default]'.  MQTT Message 
Editing Suite will not delete the MQTT Broker Profiles.

In the MQTT Brokers' dock, right click on the group name to be renamed, then select Delete 
Group…:

Click the Yes button to confirm the deletion of the group.
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4 Connecting to a MQTT Broker
This chapter will describe how to create, update, test and delete a MQTT Broker Profile.

4.1 Adding a MQTT Broker Profile
This section will describe how to add a MQTT Broker Profile so that you can connect to a local or 
remote MQTT Broker.

From the main menu of MQTT Message Editing Suite, select File then Add MQTT Broker Profile or
the user can right click on a group name in the MQTT Broker dock and select Add MQTT Broker 
Profile:

You will be prompted to provide a name for the new MQTT Broker Profile. It is suggested that you 
provide a meaningful name that describes the MQTT Broker and its location.  Note: Do not use semi-
colons ";" in the name.

If the MQTT Broker is local to where you are running MQTT Message Editing Suite then all you need
to specify is the MQTT Broker.
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Type in your valid UserId (and Password where authentication is required) for the MQTT Broker that 
you are connecting to.

For MQTT Brokers that perform authentication, the user may wish to be prompted for the password 
rather than have MQTT Message Editing Suite save it.  Click the 'Prompt for Password' checkbox to 
have MQTT Message Editing Suite prompt the user for their password for the remote system.

Optional:
For those companies that use SSL/TLS to allow mq client applications to connect to their MQTT 
Brokers, the user will need to fill in the SSL/TLS fields.

Optional:
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The 'Last Will and Testament' can be set for those connections that require it.
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4.2 Editing a MQTT Broker Profile
This section will describe how to edit a MQTT Broker Profile so that you can connect to a local or 
remote MQTT Broker.

Right click on the MQTT Broker in the 'MQTT Broker' dock and select Edit:

The MQTT Broker Profile will be presented where the user can modify/update the fields and when 
done click the OK button to save the information.
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4.3 Renaming a MQTT Broker Profile
This section will describe how to rename a MQTT Broker Profile.

Right click on the MQTT Broker in the 'MQTT Broker' dock and select Rename:

Input a new name for the MQTT Broker Profile then click the OK button.
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4.4 Move a MQTT Broker Profile to Another Group
This section will describe how to move a MQTT Broker Profile to another group.

Right click on the MQTT Broker in the 'MQTT Broker' dock and select Move To.  A list of available 
groups will be displayed and the user simply selects the appropriate group.
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4.5 Deleting a MQTT Broker Profile
This section will describe how to delete a MQTT Broker Profile.

Right click on the MQTT Broker in the 'MQTT Broker' dock and select Delete:

Click the Yes button to confirm the deletion of the MQTT Broker Profile.
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5 Managing a Topic
This chapter will describe the process of selecting, opening and managing a MQTT topic.

5.1 Retrieving a List of 'Discovered' Topics
This section will describe how to retrieve a list of discovered topics from an MQTT Broker.

Right click on the MQTT Broker in the 'MQTT Broker' dock and select List Discovered Topics:

Or the user can do the following, from the main menu of MQTT Message Editing Suite, select Topic, 
select Open Topic and then click the List button. On the Open Topic panel, select the MQTT Broker 
Profile that you want to use.
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Now select the List button to retrieve a list of discovered topics for this particular MQTT Broker.

For MQTT Broker with hundreds or thousands of topics, you can filter the topic list returned to the 
user by specifying a filter value. xyz* will return only those topic names that begin with "xyz"
i.e.
xyz/payroll/cutoff
xyz/supply/chain

The user can also combine filters together. Use a semi-colon (;) to separate each mask.
i.e.
abc*;xyz*;test*

Hence, only topics that begin with 'abc', 'xyz' and/or 'test' will be shown.

Double-click on an item in the list to select a topic string that you wish to interact with.

There are 3 options the user can select:
• Double-click to select a topic string and return to the Open Topic window.
• Open - Opens 1 or more topics and leaves the 'List of Discovered Topics' window open.
• Close - Closes the 'List of Discovered Topics' window.
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5.2 Discover Topics
This section will describe how to discover topics from an MQTT Broker.

Right click on the MQTT Broker in the 'MQTT Broker' dock and select Discover Topics:

Or the user can do the following, from the main menu of MQTT Message Editing Suite, select Topic 
then select Discover Topics to open the Discover Topics window.

Now click the Go button and the Discover Topics will gather any and all topics that messages arrive 
on.

MQTT Message Editing Suite User's Guide                                                                                          Page 26



After a reason period of time has passed, and Discover Topics window has gathered a large selection 
of topics, click the Stop button.

The user will now be presented with the Topics Discovered window that allows the user to add and/or 
delete topic strings from the list.  Once the user is happy with the list, they may save it the database.
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5.3 Organize Discovered Topics
This section will describe how to discover topics from an MQTT Broker.

Right click on the MQTT Broker in the 'MQTT Broker' dock and select Discover Topics:

Or the user can do the following, from the main menu of MQTT Message Editing Suite , select 
Topic then select Organize Discovered Topics to open the Organize Discovered Topics window.

The Organize Topics Discovered window that allows the user to add and/or delete topic strings from 
the list.  Once the user is happy with the list, they may save it the database.
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5.4 Opening a Topic
This section will describe how to open topic of a local or remote MQTT Broker. 

Right click on the MQTT Broker in the 'MQTT Broker' dock and select Open Topic then select the 
topic name from the list:

or from the main menu of MQTT Message Editing Suite, select Topic then Open Topic. On the Open 
Topic panel, select the MQTT Broker Profile that you want to use.

The following is the Open Topic Dialog panel:

There are 2 ways to input a topic name:
1. Type a topic name into the Topic String field (e.g. test/ABC/one ) and click the Open button.
2. Use the drop-down box to select a previously inputted topic name.
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There are 2 types of options that you can selected: 

• Quality of Service (QoS) - this option sets the level of agreement between sender and receiver 
of a message regarding the guarantees of delivering a message. There are 3 QoS levels: 0, 1 and
2.
◦ 0 - at most once
◦ 1 - at least once
◦ 2 - exactly once

• Retained – this options sets the retained flag to true for an MQTT message.  The broker will 
store the last retained message and the corresponding QoS for that topic.

Now that you have selected a MQTT Broker Profile and filled in the Topic Name field, select the Open
button to open the topic.

If you typed test/ABC/one then main panel may look something like: 

You can open a second, third, etc... by selecting Topic then Open Topic. On the Open Topic panel, 
select the MQTT Broker Profile and topic that you would like to open.

Note: The topic displayed will be automatically updated as new topic messages arrive. 
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5.5 Closing a Topic
This section will describe how to close an open topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Topic, then Close Topic.

Performing the Close topic option, disconnects from the MQTT Broker and clears the main panel 
display.

If the user has one or more topics open, then a quick and convenient way to close all of the topics is to 
select Topic, then Close All Topics.
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5.6 Backing up a Topic
This section will describe how to backup all or selected messages in a topic including the Message 
Properties and the message data to a Backup file.

If you have previously opened test/ABC/one, the main panel may look something like:

First, select one or more messages in the topic, then from the main panel of MQTT Message Editing 
Suite, select Topic, then Backup Topic.

The user can select the type of Backup file, the directory and/or filename and whether the messages 
should be appended or a new file is to be created.
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To change the directory, click the Browse button and then select a new directory and the name of file 
then click Save.

When the selected messages have been successfully backed up, you will be notified.
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5.7 Restoring a Topic
This section will describe how to restore messages to a topic from a Backup file.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Topic, then Restore Topic.

Select the directory and a MQT Backup File then click Open.

After the Restore action has been performed, the main panel may look something like:
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6 Manipulating the Messages
This chapter will describe the process of selecting, opening and managing a IBM MQ topic.

6.1 Cut a Message
This section will describe how to cut a message from the topic and store it in the system clipboard.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Cut Message.

Click Yes if you are sure that you want the message to be removed from the table.
Note: There is no undo function for the remove message option.

MQTT Message Editing Suite User's Guide                                                                                          Page 35



6.2 Copy a Message
This section will describe how to copy a message from the topic and store it in the system clipboard.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Copy Message.

There will be no change to the main panel. The copy action copies the message contents to the system 
clipboard.
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6.3 Paste a Message
This section will describe how to paste a message from the system clipboard to the opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Paste Message.

The main panel is updated with the message pasted from the system clipboard.
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6.4 Edit a Message
This section will describe how to edit a message in the opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message.

You can now edit, updated or delete sections of the message text. Clicking the Save button will put the
new updated message to the topic.  From the Message Edit panel, the user can select to save the 
contents to a file or load data from a file. Click the Load button to load data from a file or click the 
Save button to save the message data to a file.  For more information about the features / functions for 
the Message Edit window, go to the Message Edit section in Chapter 7.

The main panel is updated with the new message from the editing session:
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6.5 Edit a Message in Hex
This section will describe how to edit a message in Hex from the opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message in Hex.

You can now edit in hex sections of the message text. Clicking the Save button will put the new 
updated message to the topic.

The main panel is updated with the new message from the editing session.
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6.6 Edit a Message with XML Editor
This section will describe how to edit a message with the XML Editor from the opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message with XML
Editor.

You can now edit the message using the XML Editor. Clicking File then Save to Topic button will put 
the new updated message into the topic.

The main panel is updated with the new message from the editing session.
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6.7 Insert a Message
This section will describe how to insert a message into an opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Insert Message.

The Insert Message Wizard is designed to help the user quickly create an MQTT message formats.  
The user can alter the contains of the Message Properties.  Click File -> Save to Topic to save the 
message to the topic.

The main panel is updated with the new message.
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6.8 Duplicate a Message
This section will describe how to duplicate a message in the opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Duplicate Message.

The main panel will be updated with the newly inserted message.
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6.9 Forward a Message
This section will describe how to forward a message from an opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Forward Message.

Now specify a destination topic name and then click the Ok button 

Click Yes if you are sure that you want the message to be forwarded.
Note: There is no undo function for the forward message option.
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6.10Delete a Message
This section will describe how to remove a message from the displayed table of an opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Delete Message.

Click Yes if you are sure that you want the message to be removed from the table.
Note: There is no undo function for the remove message option.
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6.11Compare a Message to a File
This section will describe how to compare the contents of a message to file.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MMES, select Message, then Compare a Message to a File.

The user now selects the file to compare the message contents against.

The user now selects the file to compare the message contents against.
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6.12Printing a Message
This section will describe how to print a message to a printer from an opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Print Message.

The user now selects the printer to print the message on.
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6.13Generate Report
This section will describe how to generate a report (PDF, RTF or HTML) from the selected messages.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Generate Report.

The user now selects how the messages are to be generated into the report:

• The user may use the Browse button to select the directory and file name to be used for the 
report file.

• The user can select PDF or RTF or HTML for the report type.
• The user can select Raw Data or Hex Data or EBCDIC Hex for how the message data will be 

formatted in the report.

The user can select to include the message's Message Properties in the report.  Click Save to generate 
the report.

Click Ok
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6.14Importing Files
This section will describe how to import one or more files as message into an opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Insert File.

Now select one or more files or change directories to locate the files and then click Open
Note: You can select more than one file in this dialog box. Use either the Shift or Ctl keys when 
selecting the files.

The Import File Wizard is designed to help the user quickly create an MQTT message.  The user can 
also alter the contains of the Message Properties.

There are 3 file options when importing files:

• Each file as a message
• Every line of each file - a message will be created for each line (record) in every individual file
• Delimited File – the file will be parsed, based on the delimiter, into sections and each parsed 

section will be a message.
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Note: The Import File Wizard will put all messages to the topic using the MQTT message format that 
the user creates in this step.

The main panel is updated with the 3 new messages.
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6.15Exporting Messages
This section will describe how to export a message to a file from an opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Export Message.

The user now selects how the messages are to be outputted to a file:

• Select Each message to a separate file for separate files for each message in the topic.
• Select All selected messages to the same file for 1 (one) output file. The single file will 

contain all selected messages that will be exported.

Trailor Text
• Select Append Trailer Text to add user defined text to the end of each message as it is saved 

to the file. Use "\n" to represent CRLF on Windows and LF on Unix/Linux.

The user may use the Browse button to select the directory and file name to be used for the exporting.  
Click Save to export the messages to a file.

Click Ok.
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6.16Find
This section will describe how to use the Find feature. The Find function allows the user to search the 
messages of the topic for a particular text string.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Find.

After clicking Find, if a match is found, the table cell containing the matching string will be 
highlighted in yellow.

When you are done searching, click the Cancel button. The row containing the last matching search 
string will be highlighted.
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7 Message Edit
This chapter will describe the various docks of the Message Edit window.

7.1 Message Data Dock
This section will describe how to edit a message in the opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message.

You can now edit, updated or delete sections of the message text. Clicking the File -> Save to Topic 
will put the new updated message to the topic.
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The following are the dropdown menus that currently exist for the Message Edit Window.

Under File:
• Load from File - Allows the user to load (import) the contains of a text file into the current 

message text.
• Save to File - Allows the user to save the message content to a plain text file.
• Publish to Topic - Allows the user to save the message to the topic (use this function after a 

change or update to the message content and/or the Message Properties.)
• Print Message - Allows the user to print the message
• Close - Allows the user to discard the Message Edit window and return to the main window.

Under Edit:
• Cut - Allows user to cut part or all of the message content to the system's clipboard.
• Copy - Allows user to copy part or all of the message content to the system's clipboard.
• Paste - Allows user to paste from the system's clipboard into the message content.
• Find - Provides the user with the ability to search the message content for a specific string.
• Replace - Provides the user with the ability to search the message content for a specific string 

and replace the string with another string.

Under Message:
• User Formats - Allows user to define a message format for the data.
• Apply Format - Allows user to apply a specific message format to the data.

Under View:
• Wrap Text - Allows the user to toggle the message content's display between wrapped and 

unwrapped text.
• Select All - Allows the user to quickly select all of the message's content.
• Unselect All - Turns the selection off (if on) and sets the cursor to column 1 of row 1.

Under Help:
• Help - Allows the user to display the MQTT Message Editing Suite User Guide.
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In the message content window of the Message Data dock, if the user performs a right-mouse click 
then a popup window will be displayed. The user will be able to do the following:

• Cut - Allows user to cut part or all of the message content to the system's clipboard.
• Copy - Allows user to copy part or all of the message content to the system's clipboard.
• Paste - Allows user to paste from the system's clipboard into the message content.
• Find - Provides the user with the ability to search the message content for a specific string.
• Load from File - Allows the user to load (import) the contains of a text file into the current 

message text.
• Save to File - Allows the user to save the message content to a plain text file.

The main panel is updated with the new message from the editing session:
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7.2 XML Viewer Dock
This section will describe how to edit a message in the opened topic. If the data is well formed XML 
then the XML Viewer will be able to display it.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message.

The XML data is shown in a tree view. The user can expand any entry they wish to. This will allow 
them to view attributes, nodes and data with the XML data.  Clicking the Save button will put the new 
updated message into the topic.

The main panel is updated with the new message from the editing session:
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7.3 JSON Viewer Dock
This section will describe how to edit a message in the opened topic. If the data is well formed JSON 
(JavaScript Object Notation) data then the JSON Viewer will be able to display it.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message.

The JSON data is shown in a tree view. Clicking the Save button will put the new updated message 
into the topic.

The main panel is updated with the new message from the editing session:
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7.4 Fixed Width Viewer Dock
This section will describe how to view a message in the opened topic. If a Fixed Width format has 
been created then data can be formatted using it.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message then click 
the Fixed Width Viewer button.

If there is a Fixed Width user format defined for the opened queue then MQTT Message Editing Suite 
will automatically use it when the Fixed Width Viewer dock button is clicked.

If there is no Fixed Width user format defined for the opened queue then the user can manually select 
one of the Fixed Width user formats by clicking Message - > Apply Format - > XXXX where XXXX 
is one of the Fixed Width user formats.
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7.5 CSV Viewer Dock
This section will describe how to view a message in the opened topic. The data can be viewed with or 
without a CSV format.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message to open the
message in the Message Edit window.
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Click the CSV Viewer button to view the message in the CSV Viewer.

If there is a CSV user format defined for the opened queue then MQTT Message Editing Suite will 
automatically use it when the CSV Viewer dock button is clicked.

Note: If a CSV format is not being used and the first row of data contains the header row, then click 
View - > Use first row for column names menu item to display it.

If there is no CSV user format defined for the opened queue then the user can manually select one of 
the CSV user formats by clicking Message - > Apply Format - > XXXX where XXXX is one of the 
CSV user formats.
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7.6 FIX Viewer Dock
This section will describe how to view a message in the opened topic. The data can be viewed with or 
without a FIX format.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message to open the
message in the Message Edit window.
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Click the FIX Viewer button to view the message in the FIX Viewer.

If there is a FIX user format defined for the opened queue then MQTT Message Editing Suite will 
automatically use it when the FIX Viewer dock button is clicked.

Note: If a FIX format is not being used and the first row of data contains the header row, then click 
View - > Use first row for column names menu item to display it.

If there is no FIX user format defined for the opened queue then the user can manually select one of 
the FIX user formats by clicking Message - > Apply Format - > XXXX where XXXX is one of the FIX
user formats.
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7.7 Hex Data Dock
This section will describe how to edit a message in the opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message.

In the columns of 0,1,2,3,4,5,6,7,8,9,0,A,B,C,D,E,F, you can alter the message content by using 
hexadecimal values. Clicking the Save button will put the new updated message into the topic.

Under File:
• Save to Topic - Allows the user to save the message back to the topic (use this function after a 

change or update to the message content and/or the Message Properties.)
• Print Message - Allows the user to print the message.

Under Edit:
• Copy - Allows user to copy part or all of the message content to the system's clipboard.
• Find - Provides the user with the ability to search the message content for a specific string.
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Under Help:
• Help - Allows the user to display the help files.

In the Hex Data tab, if the user performs a right-mouse click then a popup window will be displayed. 
The user will be able to do the following:

• Copy - Allows user to copy part or all of the message content to the system's clipboard.
• Find - Provides the user with the ability to search the message content for a specific string.
• Close - Close the Message Edit window.

The main panel is updated with the new message from the editing session:
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7.8 Message Header Dock
This section will describe how to edit a message in the opened topic.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Message, then Edit Message.

The user may alter any value on any of the Message Properties dock.  For more information about 
editing the Message Header, go to chapter 8.  Clicking the Save button will put the new updated 
message into the topic.

The main panel is updated with the new message from the editing session:
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8 User Formats
This chapter will describe how to create, update and delete user defined formats.  User formats allows 
the end-user to define formats for user specific data.  Currently, MQTT Message Editing Suite 
supports 3 different types of user formats:

• Fixed Width format
• CSV (Comma Separated Value) format
• FIX (Financial Information eXchange) format

There are 2 ways to access the user formats in MQTT Message Editing Suite:

• On the main window, click Message - > User Formats
• On the edit window, click Message - > User Formats
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8.1 Fixed Width Format
This section will describe how to add, edit and delete Fixed Width formats.

8.1.1 Add a Fixed Width Format
This section will describe how to add a Fixed Width format.  

First, click the Add button, input a unique name for this new Fixed Width Format and click the OK 
button. 
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8.1.1.1 Field Definition

Next, on the Fixed Width Layout window, the user can add fields to the layout format by clicking the 
Add button.

Input a name for the field, select the type of data that is represented by this field, the start position and 
the length of the field then click the OK button.

Note: For type do not select Integer, Long or Short if the data is NOT in binary format representation 
of the field.  Also, the Endianess applies to Integer, Long and Short binary fields on how the binary 
data is laid out.

8.1.1.2 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.
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8.1.1.3 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

8.1.1.4 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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8.1.2 Edit a Fixed Width Format
This section will describe how to edit a Fixed Width format.  

Click the Edit button (or double left click on the format name) to open the Fixed Width Layout 
window.

8.1.2.1 Field Definition

On the Fixed Width Layout window, the user can add, edit or delete fields of the layout format.

8.1.2.2 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.
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8.1.2.3 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

8.1.2.4 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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8.1.3 Rename a Fixed Width Format
This section will describe how to rename a Fixed Width format.  

First, click the Rename button.

Now specify a new format name then click the OK button.
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8.1.4 Delete a Fixed Width Format
This section will describe how to delete a Fixed Width format.  

First, click the Delete button.

Click the Yes button to confirm the deletion of the particular Fixed Width format.
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8.2 CSV Format
This section will describe how to add, edit and delete CSV (Comma Separated Value) formats.

8.2.1 Add a CSV Format
This section will describe how to add a CSV format.  

First, click the Add button, input a unique name for this new CSV Format and click the OK button. 
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8.2.1.1 Field Definition

Next, on the CSV Layout window, the user can add fields to the layout format by clicking the Add 
button.

Input a name for the CSV column then click the OK button.

8.2.1.2 Field Delimiter
The Field Delimiter states how each column is separated from the next column.  The default is 
“Comma”.  The user can change it to one of the other values in the dropdown.

8.2.1.3 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.
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8.2.1.4 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

8.2.1.5 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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8.2.2 Edit a CSV Format
This section will describe how to edit a CSV format.  

Click the Edit button (or double left click on the format name) to open the CSV Layout window.

8.2.2.1 Field Definition

On the CSV Layout window, the user can add, edit or delete fields of the layout format.

8.2.2.2 Field Delimiter
The Field Delimiter states how each column is separated from the next column.  The default is 
“Comma”.  The user can change it to one of the other values in the dropdown.

8.2.2.3 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.
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8.2.2.4 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

8.2.2.5 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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8.2.3 Rename a CSV Format
This section will describe how to rename a CSV format.  

First, click the Rename button.

Now specify a new format name then click the OK button.
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8.2.4 Delete a CSV Format
This section will describe how to delete a CSV format.  

First, click the Delete button.

Click the Yes button to confirm the deletion of the particular CSV format.
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8.3 FIX Format
This section will describe how to add, edit and delete FIX (Financial Information eXchange) formats.

8.3.1 Add a FIX Format
This section will describe how to add a FIX format.  

First, click the Add button, input a unique name for this new FIX Format and click the OK button. 
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8.3.1.1 Field Definition

Next, on the FIX Layout window, the user can add fields to the layout format by clicking the Add 
button.

Input a name for the FIX column then click the OK button.

8.3.1.2 Field Delimiter
The Field Delimiter states how each column is separated from the next column.  The default is “SOH 
(x’01’)”.  The user can change it to one of the other values in the dropdown.

8.3.1.3 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.
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8.3.1.4 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

8.3.1.5 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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8.3.2 Edit a FIX Format
This section will describe how to edit a FIX format.  

Click the Edit button (or double left click on the format name) to open the FIX Layout window.

8.3.2.1 Field Delimiter

On the FIX Layout window, the user can add, edit or delete fields of the layout format.

8.3.2.2 Field Delimiter
The Field Delimiter states how each column is separated from the next column.  The default is “SOH 
(x’01’)”.  The user can change it to one of the other values in the dropdown.

8.3.2.3 Record Separator
The Record Separator states how each row is laid out in the message data.  The default is “New Line”.
The user can change it to one of the other values in the dropdown.
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8.3.2.4 Object Names to be formatted
The Object Names to be formatted is a list of queues and topics that the format will be automatically 
applied to when the user clicks the Fixed Width Viewer in the Edit Message Window.  This parameter 
is optional.

The Object Names to be formatted can be the fully qualified queue or topic name or it can be a regular
expression pattern.

In the regular expression pattern:
• '*' matches any sequence of characters (zero or more)
• '?' matches any single character
• '#' matches any single numeric digit (0-9)
• '@' matches any single alphabetic character (A-Z, a-z)
• [SET] matches any of the characters in the specified set
• [!SET] or [^SET] matches any character except those specified in the set (negation).

A SET can be composed of characters or ranges.  A range is in the form: 'character – character' (i.e. 0-9
or A-Z).  Although this is the simplest range allowed in the [ ] pattern, more complex inclusive ranges 
such as [0-9a-zA-Z] are allowed.  [0-9a-zA-Z] specifies that the character can be 0 through 9 or a 
through z or A through Z.  Other characters are allowed (ie. 8 bit characters) if your system supports 
them.  

In order to suppress the special syntactic significance of any of these characters  '[] * ? # @ ! ^ - \', a 
backslash ('\') must precede the special character.

8.3.2.5 Saving Format
When you are done inputting fields, click the Save button to the new layout to the database.
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8.3.3 Rename a FIX Format
This section will describe how to rename a FIX format.  

First, click the Rename button.

Now specify a new format name then click the OK button.
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8.3.4 Delete a FIX Format
This section will describe how to delete a FIX format.  

First, click the Delete button.

Click the Yes button to confirm the deletion of the particular FIX format.
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9 Favorites
This chapter will describe how to add a favorite or organize the user's list of favorites. Favorites is 
similar to Internet Explorer's favorites but rather than adding a favorite web site, the user adds a 
favorite topic and MQTT Broker combination.

9.1 Add Favorite
This section will describe how to add a favorite topic & MQTT Broker combination to the user's 
favorite list.

If you have previously opened topic test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select Favorite, then Add to Favorites.

There will be no change to the main panel. The action sets the topic and MQTT Broker combination as
a favorite to the user's favorite list.
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9.2 Open Favorite
This section will describe how to open a favorite topic and MQTT Broker combination.

From the main window when no topics are open, MQTT Message Editing Suite will look like:

From the main panel of MQTT Message Editing Suite, select Favorite, then click the favorite to be 
opened (i.e. 'test/ABC/one') and the topic will be opened.
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9.3 Organize Favorite
This section will describe how to organize the user's list of favorites. MQTT Message Editing Suite's 
favorites are very similar to Internet Explorer's favorites. Basically, it gives the user a very quick way 
to return to a previously opened topic and MQTT Broker combination.

From the main window when no topics are open, MQTT Message Editing Suite will look like:

From the main panel of MQTT Message Editing Suite, select Favorite, then Organize Favorites.

The user can do the following actions:
• Move favorites up or down
• Delete a favorite
• Directly Open a favorite
• Save the updated favorite list when they are done.
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10 Stress Testing Tools
This chapter will describes how to invoke and use the Stress Testing Tools included with MQTT 
Message Editing Suite. 

10.1Subscribe Server
This section will describe how to invoke and use the Subscribe Server Stress Testing tool. The 
Subscribe Server will continuously consume messages of a topic and show statistics of its current state.
For the Stress Testing Servers (Subscribe & Publish Servers), you can have unlimited number of them 
running (up to what your box can support). Also, while any of the Servers are running, the user can 
still use MQTT Message Editing Suite.

From the main panel of MQTT Message Editing Suite, select MQTT Tools, then Subscribe Server.

This is the main panel of the Subscribe Server. The user will need to select the topic and MQTT 
Broker before starting the Subscribe Server. Click the Select button to choose the topic and MQTT 
Broker.

This is the standard 'Open Topic' dialog. Select the topic and MQTT Broker then click the Open 
button.
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Once the topic and MQTT Broker have been selected, the user can now start the Subscribe Server by 
clicking the Start button.

While the Subscribe Server is running, the current statistics are displayed and updated. To stop the 
execution of the Subscribe Server click the Stop button.
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10.2Publish Server
This section will describe how to invoke and use the Publish Server Stress Testing tool. The Publish 
Server will publish (put) messages to a topic. It can be used to stress test a 'Server Component'. The 
user can control the feed by putting a delay between the putting messages to a topic. The messages data
can be from a simple input text or from a plain text file or from a Backup file.

For the Stress Testing Servers (Subscribe & Publish Servers), you can have unlimited number of them 
running (up to what your box can support). Also, while any of the Servers are running, the user can 
still use MQTT Message Editing Suite.

From the main panel of MQTT Message Editing Suite, select MQTT Tools, then Publish Server.

This is the main panel of the Publish Server. The user will need to select the topic and MQTT Broker 
before starting the Publish Server. Click the Select button to choose the topic and MQTT Broker.
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This is the standard 'Open Topic' dialog. Select the topic and MQTT Broker then click the Open 
button.

Once the topic and MQTT Broker have been selected, the user can provide more information:

• The user can select a delay between puts.
• The user can select the number of messages to be written. Note: A blank in this field means an 

UNLIMITED number of puts will be done (it will run forever).
• The user is required to select a Data Source. The message text can come from 1 of 3 sources:

1. The user can input simple text in the text box on the Publish Server panel. The Message 
Properties will default to whatever the topic defaults attributes are.

2. The user can select a text file to be used as the message text. The Message Properties 
header will default to whatever the topic defaults attributes are.

3. The user can select a Backup File.  A Backup file can have multiple messages in it. 
Therefore, each message in the Backup file will be written as separate messages to the 
topic. Note: If max messages is set to 100 and there are 8 messages in the Backup file then 
a total of 800 messages will be written to the topic.

MQTT Message Editing Suite User's Guide                                                                                          Page 93



After filling in the required information, the user can start the Publish Server by clicking the Start 
button.

While the Publish Server is running, the current statistics are displayed and updated. To stop the 
execution of the Publish Server click the Stop button.
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11 Monitoring Tools
This chapter will describes how to invoke and use the Monitoring Tools included with MQTT Message
Editing Suite. 

11.1Find Retained Messages
This section will describe how to invoke and use the Find Retained Messages tool. The Find Retained 
Messages will collect and display topics that have a message with the retained flag set to true.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQTT Message Editing Suite.

From the main panel of MQTT Message Editing Suite, select MQTT Tools, then Find Retained 
Messages.

This is the main panel of the Find Retained Messages. Click the Start button to choose the broker and 
options.

This is the 'Find Retained Messages' selection window, where the user selects the MQTT Broker and 
clicks the Go button.
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When the user is done collecting topics with retained messages, click the Stop button.

Next, a window will be displayed to the user and the user has the option of selecting 1 or more topics 
to have the retained messages deleted.

The user will be prompted to verify that the selected topics are to have the retained messages deleted.
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11.2Visualize Message Data
This section will describe how to invoke and use the Visualize Message Data monitoring tool. The 
Visualize Message Data monitoring tool will continuously collect the data of incoming messages of a 
topic and display the message data values in a chart.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQTT Message Editing Suite.

From the main panel of MQTT Message Editing Suite, select MQTT Tools, then Visualize Message 
Data.

This is the main panel of the Visualize Message Data. Click the Start button to choose the broker and 
options.

This is the 'Visualize Message Data' selection window, where the user selects the MQTT Broker. The 
topic, options and how the 'Visualize Message Data' monitoring tool is to interrupt/find the value in the
message data and finally click the Go button.

Visualize Message Data monitoring tool supports extracting 3 types of message data:
• Raw – raw means that only a single decimal number is the message data
• XML – For XML, the user specifies the Tag name that holds the decimal number 
• JSON – For JSON, the user specifies the Field name that holds the decimal number 
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As the Visualize Message Data monitoring tool is running, each time it receive a message, the message
data will be parsed and chart will be updated.  The "Last Refreshed" field in the toolbar will also be 
updated.

To stop the Visualize Message Data, simply click the Stop button.
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11.3Message Moving Average
This section will describe how to invoke and use the Message Moving Average monitoring tool. The 
Message Moving Average monitoring tool will continuously collect messages from the user specified 
topics and update the various time periods.  There are 7 time periods: 1, 5, 10, 15, 30, 45 and 60 
minutes. 

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQTT Message Editing Suite.

From the main panel of MQTT Message Editing Suite, select MQTT Tools, then Message Moving 
Average.

This is the main panel of the Message Moving Average. Click the Start button to choose the broker 
and options.

This is the 'Message Moving Average' selection window, where the user selects the MQTT Broker and 
clicks the Go button.
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As the Message Moving Average monitoring tool is running, it will update the message counts for 
each topic in each time period.

To stop the Message Moving Average, simply click the Stop button.
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11.4Visual Message Count
This section will describe how to invoke and use the Visual Message Count monitoring tool. The 
Visual Message Count monitoring tool will continuously monitor the user specified topics of a broker 
visually displaying the message count over the last 60 seconds.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQTT Message Editing Suite.

From the main panel of MQTT Message Editing Suite, select MQTT Tools, then Visual Message 
Count.

This is the main panel of the Visual Message Count. Click the Start button to choose the broker and 
options.

This is the 'Visual Message Count' selection window, where the user selects the MQTT Broker and 
clicks the Go button.
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As the Visual Message Count monitoring tool is running, it will display the message count per topic 
over a 60 second period.

To stop the Visual Message Count, simply click the Stop button.
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11.5Ping Broker
This section will describe how to invoke and use the Ping Broker monitoring tool. The Ping Broker 
monitoring tool will test if a broker is up and running and how long it takes to publish and receives 
messages to and from the broker.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQTT Message Editing Suite.

From the main panel of MQTT Message Editing Suite, select MQTT Tools, then Ping Broker.

This is the main panel of the Ping Broker. Click the Start button to choose the broker and options.

First the user needs to select the broker to be pinged.  This is the 'Ping Broker' selection window, 
where the user selects the MQTT Broker and clicks the Open button.
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Click the Start button to begin the ping test of the broker.  Note: The user can select more or fewer 
ping tests to be done.

As the Ping Broker monitoring tool is running, the window will be updated with the current values 
from each ping test.

To stop the Ping Broker monitoring tool, simply click the Stop button.  Note: The Ping Broker 
monitoring tool will automatically stop when all of the selected tests are completed.
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11.6Broker Status Monitor
This section will describe how to invoke and use the Broker Status Monitor tool. The Broker Status 
Monitor will continuously monitor the status of the broker.

For the MQ Tools, you can have unlimited number of them running (up to what your box can support).
Also, while any of the MQ Tools are running, the user can still use MQTT Message Editing Suite.

Note: Currently, IBM MQ does not support "$SYS Topic" messages as defined on the following web 
page: https://github.com/mqtt/mqtt.github.io/wiki/SYS-Topics

From the main panel of MQTT Message Editing Suite, select MQTT Tools, then Broker Status 
Monitor.

This is the main panel of the Broker Status Monitor. Click the Start button to choose the broker and 
options.

This is the 'Broker Status Monitor' selection window, where the user selects the MQTT Broker and 
clicks the Go button.
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As the Broker Status Monitor monitoring tool is running, it will receive "$SYS Topic" messages and 
popular the screen.  Each time a field is updated, the "Last Refreshed" field in the toolbar will also be 
updated.

The "$SYS Topics" that Broker Status Monitor subscribes to are the common topics as defined on the 
following web page: https://github.com/mqtt/mqtt.github.io/wiki/SYS-Topics

To stop the Broker Status Monitor, simply click the Stop button.

MQTT Message Editing Suite User's Guide                                                                                          Page 106



12 Other Tools
This chapter will describes how the other tools included with MQTT Message Editing Suite.

12.1Hex Converter
This section will describe how to invoke and use the Hex Converter tool. Hex Converter tool can 
convert a hexadecimal number to its corresponding string representation and vice versa. i.e. 
0x'3132333041424344' to '1230ABCD'.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQTT Message Editing
Suite.

From the main panel of MQTT Message Editing Suite, select Tools, then Hex Converter.

This is the main panel of the Hex Converter.

• The user first selects the Conversion type: "Hex to Character" or "Character to Hex"
• Input the value hex or character value into the "Input Value" field
• Click the Convert button to convert the data
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12.2Hex Editor
This section will describe how to invoke and use the Hex Editor tool. The Hex Editor is a simple 
multipurpose hex editor. The Hex Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQTT Message Editing
Suite.

From the main panel of MQTT Message Editing Suite, select Tools, then Hex Editor.

This is the main panel of the Hex Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Recent File List
• Copy, Find and Find Next
• Save, Save As and Print
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12.3Tail File
This section will describe how to invoke and use the Tail File tool. The Tail File is a simple 
multipurpose file monitoring viewer. The Tail File supports monitoring of multiple files at the same 
time.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQTT Message Editing
Suite.

From the main panel of MQTT Message Editing Suite, select Tools, then Tail File.

This is the main panel of the Tail File and it has 3 open files.

Supported features:
• Opening of multiple files
• Wrap Text and Recent File List
• Copy, Find, Find Next and Print
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12.4Text Editor
This section will describe how to invoke and use the Text Editor tool. The Text Editor is a simple 
multipurpose plain-text editor. The Text Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQTT Message Editing
Suite.

From the main panel of MQTT Message Editing Suite, select Tools, then Text Editor.

This is the main panel of the Text Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Builtin XML Viewer, Wrap Text
• Recent File List
• Cut, Copy, Paste, Find and Find Next
• Save, Save As and Print
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The following shows the Text Editor's builtin XML Viewer.
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12.5Visual Difference
This section will describe how to invoke and use the Visual Difference tool. The Visual Difference is a
simple file to file comparison tool.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQTT Message Editing
Suite.

From the main panel of MQTT Message Editing Suite, select Tools, then Visual Difference.

This is the main panel of the Visual Difference. To initiate the file comparison process, click File and 
then click Compare File to File

First the user needs to select the first file for the comparison.
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Next, the user needs to select the second file for the comparison.

The following shows the difference between 2 files. Differences are highlighted: Green for inserts, Red
for deletions and Blue for changes.
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12.6XML Editor
This section will describe how to invoke and use the XML Editor tool. The XML Editor is a simple 
multipurpose plain-text editor. The XML Editor supports multi-file editing.

For the Other Tools, you can have unlimited number of them running (up to what your box can 
support). Also, while any of the Other Tools are running, the user can still use MQTT Message Editing
Suite.

From the main panel of MQTT Message Editing Suite, select Tools, then XML Editor.

This is the main panel of the XML Editor and it has 3 open files.

Supported features:
• Open / editing of multiple files
• Recent File List
• Copy, Find and Find Next
• Save, Save As and Print
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13 Miscellaneous
This chapter will describes how the miscellaneous features of MQTT Message Editing Suite.

13.1Preferences
This section will describe how to change / update your preferences for MQTT Message Editing Suite.

From the main panel of MQTT Message Editing Suite, select File then Preferences.  The user will be 
presented with a popup window that has 4 panels.

General Preferences:
• Start the tools in a separate JVM - If the user wants the tools to be launched in a separate 

JVM then select this checkbox.
• User Directory - You can specify where MQTT Message Editing Suite will store the 

BrokerInfo.db and UserFormats.db. The BrokerInfo.db contains all of the information 
necessary to connect to an MQTT Broker.

Font Sizes:
• Variable Width – The font size to be used for all variable width fonts in MQTT Message 

Editing Suite.
• Fixed Width – The font size to be used for all fixed width fonts in MQTT Message Editing 

Suite.

Networking Properties:
• Enable Proxy Server - MQTT Message Editing Suite needs to access the internet to register 

the product and for continued use.  Enable this item if your company uses a Proxy Server.
• Proxy Host - The Proxy Server address that your company uses.
• Proxy Port - The Proxy Port number that your company uses.

Main Window Preferences:
• Position of toolbar in the Main window - The user can select Top, Bottom, Left or Right.
• Size of each column (10-1024) - The user can set the size of the columns in the Main window. 

The user can have a column of data as small as 10 characters or as large as 1024 characters.
New Messages:
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• Automatically scroll the table to the new message – Set the default behavior when a new 
topic is opened whether or not the view should be automatically scrolled to the newest 
message.

• Insert new messages at the top of the table - New messages will be put into the table at top.
• Insert new messages at the top of the table - New messages will be put into the table at top.
• Background Image – Choices are: Default, User or None.  If the ‘User’ is chosen then the 

user can select an image from their local computer to use.
Display Docks in Main window:

• Show 'MQTT Brokers' dock - The user show or not the 'MQTT Brokers' dock in the Main 
window.

• Show 'Status' dock - The user show or not the 'Topic Status' dock in the Main window.
• Show 'Message Header' dock - The user show or not the 'Message Header' dock in the Main 

window.
• Show 'Message Properties' dock - The user show or not the 'Message Properties' dock in the 

Main window.
Position of Docks in Main window:

• Position of 'MQTT Brokers' dock - The user can the location of the 'MQTT Brokers' dock in 
the Main window.

• Position of 'Status' dock - The user can the location of the 'Topic Status' dock in the Main 
window.

• Position of 'Message Header' dock - The user can the location of the 'Message Header' dock 
in the Main window.

• Position of 'Message Properties' dock - The user can the location of the 'Message Properties' 
dock in the Main window.
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Edit Window Preferences:
• Wrap text in Message Edit Window - Set the default action for 'Wrap Text' in the Message 

Edit window.
• Show line numbers in Message Edit Window - Set the default action for 'line numbers' in the 

Message Edit window.

The following are default values for the CSV Viewer when no user format is being used:
• Use first row for column names – The first row of the data will be used as the column header 

row.
• Field Delimiter – Specifies the default field delimiter to be used for CSV data.
• Record Separator – Specifies the default record separator to be used for CSV data.

The following are default values for the FIX Viewer when no user format is being used:
• Use first row for column names – The first row of the data will be used as the column header 

row.
• Field Delimiter – Specifies the default field delimiter to be used for FIX data.
• Record Separator – Specifies the default record separator to be used for FIX data.

MQTT Message Editing Suite User's Guide                                                                                          Page 117



Topic Preferences:

Default values for Open Topic:
• Quality of Service (QoS) - The user can set the default value for 'Quality of Service'.
• Retained - The user can set the default value for 'Retained'.

Default values for Export:
• Message / File Handling - Either create a file for each message or write all message to the 

same file.
• Append Trailer Text – Enable to add trailer text to each message.
• Trailer Text – Field for adding trailer text.

To save your preferences, click the Ok button. To quit or cancel from the Preferences popup menu, 
click the Cancel button.  If you clicked the Ok button, then you should receive the "Preferences Saved"
popup menu.  Note: The main display will be reset when the preferences are saved.
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13.2Language
This section will describe how to switch MQTT Message Editing Suite's Language Text to another 
Language Text. MQTT Message Editing Suite has been designed to support Java's multi-language 
environment.  Currently, MQTT Message Editing Suite has full language support for the following 55 
languages:

 Amharic (am)
 Arabic (ar)
 Azerbaijani (az)
 Bengali (bn)
 Cebuano (ceb)
 Chinese (China) (zh)
 Chinese (Taiwan) (zh)
 Czech (cs)
 Danish (da)
 Dutch (nl)
 English (en)
 Finnish (fi)
 French (fr)
 German (de)
 Greek (el)
 Gujarati (gu)
 Hausa (ha)
 Hebrew (iw)
 Hindi (hi)

 Hungarian (hu)
 Igbo (ig)
 Indonesian (in)
 Italian (it)
 Japanese (ja)
 Javanese jv)
 Kannada (kn)
 Korean (ko)
 Malay (ms)
 Malayalam (ml)
 Marathi (mr)
 Norwegian (no)
 Panjabi (pa)
 Pashto (ps)
 Persian (fa)
 Polish (pl)
 Portuguese (pt)
 Romanian (ro)
 Russian (ru)

 Shona (sn)
 Sindhi (sd)
 Spanish (es)
 Sundanese (su)
 Swahili (sw)
 Swedish (sv)
 Tamil (ta)
 Telugu (te)
 Thai (th)
 Turkish (tr)
 Ukrainian (uk)
 Urdu (ur)
 Uzbek (uz)
 Vietnamese (vi)
 Xhosa (xh)
 Yoruba (yo)
 Zulu (zu)

From the main panel of MQTT Message Editing Suite, select View, then Language. Then select the 
language the user wishes to view  MQTT Message Editing Suite in.
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13.3Follow New Messages
This section will describe how to enable or disable the option of having the view move to the newest 
message inserted into the table in the main panel.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select View, then Follow New Messages 
(unselect the option).

The main panel will not scroll when new messages are inserted, as per below:
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13.4Select All Messages
This section will describe how to select all of the messages displayed in the main panel.

If you have previously opened test/ABC/one, the main panel may look something like:

From the main panel of MQTT Message Editing Suite, select View, then Select All.

The main panel should have all of the messages selected, as per below:
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13.5Unselect All Messages
This section will describe how to unselect all of the messages displayed in the main panel.

If you have previously opened the topic test/ABC/one with all messages selected, then the main panel 
may look something like:

From the main panel of MQTT Message Editing Suite, select View, then Unselect All.

The main panel should have all of the messages selected, as per below:
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14 Appendix A – Mouse and Keyboard Actions
This section describes the buttons on MQTT Message Editing Suite's toolbar.

14.1Toolbar

• Open Topic - Clicking the Open Topic button will display the Open Topic window.
• Close Topic - Clicking the Close Topic button will remove the currently displayed dock.
• Backup Topic - Clicking the Backup Topic button will all messages or selected messages to a 

file. 
• Restore Topic - Clicking the Restore Topix button will load (restore) messages from a backed 

up file. 
• Insert Message - Clicking the Insert Message button will display the Message Edit window. 

Contents of the Message Edit window will be empty.
• Edit Message - Clicking the Edit Message button will display the selected message in the 

Message Edit window.
• Forward Message - Clicking the Forward Message button will display the Forward Message 

window, so that the selected message can be forwarded (copy the message from current topic 
and put it to another topic). One or more messages can be forwarded.

• Delete Message - Clicking the Delete Message button will remove the selected messages from 
the table being displayed.

• Cut Message - Clicking the Cut Message button will "cut" the messages from the topic and 
into the computer's clipboard. Note: If you "cut" more than one message, all of the messages 
will be combined and placed in the clipboard as one message.

• Copy Message - Clicking the Copy Message button will "copy" the messages from the topic 
and into the computer's clipboard. Note: If you "copy" more than one message, all of the 
messages will be combined and placed in the clipboard as one message.

• Paste Message - Clicking the Paste Message button will copy the contains of the clipboard 
(whatever that may be) to a new message and put in the topic.

• Find - Clicking the Find button will display the Find window. The Find window allows the 
user to search for a text string that may be contained within one of the messages in the topic.

• Print Message - Clicking the Print Message button will prompt the user to confirm that you 
wish to print the selected message.

• Generate Report - Clicking the Generate Repor button will prompt the user to select the 
values (report type, report format, etc.) for the report generation.

• Preferences - Clicking the Preferences button will display the preferences popup dialog box.
• Help - Clicking the Help button will display MQTT Message Editing Suite's Help system. The 

Help system provides various information about how and what features and functions are 
available in MQTT Message Editing Suite.
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14.2Mousing Around in MQTT Message Editing Suite

14.2.1 Left Button
• In the main window of MQTT Message Editing Suite, while displaying messages of an opened 

topic, if the user double clicks the left mouse button, then the selected message will be display 
in the Message Edit window.

14.2.2 Right Button
In the main window of MQTT Message Editing Suite, while displaying messages of an opened topic, if
the user clicks the right mouse button, then the following popup menu will be displayed.

• Copy Message - Selecting the Cut Message menu item will "cut" the messages from the topic 
and into the computer's clipboard. Note: If you "cut" more than one message, all of the 
messages will be combined and placed in the clipboard as one message.

• Copy Message - Selecting the Copy Message menu item will "copy" the messages from the 
topic and into the computer's clipboard. Note: If you "copy" more than one message, all of the 
messages will be combined and placed in the clipboard as one message.

• Paste Message - Selecting the Paste Message menu item will paste the contains of the 
clipboard (whatever that may be) to a new message and put to the topic.

• Edit Message - Selecting the Edit Message menu item will display the selected message in the 
Message Edit window.

• Edit Message in Hex - Selecting the Edit Message in Hex menu item will display the selected 
message in the Hex Message Edit window.

• Edit Message with XML Editor - Selecting the Edit Message with XML Editor menu item 
will display the selected message in the XML Editor window.

• Insert Message - Selecting the Insert Message menu item will display the Message Edit 
window. Contents of the Message Edit window will be empty.

• Duplicate Message - Selecting the Duplicate Message menu item will replicate all the selected 
message(s) to the current topic. One or more messages can be duplicated.
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• Forward Message - Selecting the Forward Message menu item will display the Forward 
Message window, so that the selected message can be forwarded (copy the message from 
current topic and put to another topic). One or more messages can be forwarded.

• Delete Message - Clicking the Delete Message button will remove the selected messages from 
the table being displayed.

• Find - Selecting the Find menu item will display the Find window. The Find window allows 
the user to search for a text string that may be contained within one of the messages in the 
topic.

• Find Next - Selecting the Find Next menu item will display the Find window but the search 
will continue from the previous search position.

• Select All - Selecting the Select All menu item will select (highlight) all messages in the topic.
• Unselect All - Selecting the Unselect All menu item will de-select (un-highlight) all messages 

in the topic.
• Close Topic - Clicking the Close Topic button will remove the currently displayed tab.
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14.3Keyboard short-cuts in MQTT Message Editing Suite
There are many short-cut (accelerator) key combinations in MQTT Message Editing Suite.

Note: Ctrl means press and hold the Control key and then press the key after the "-" (minus sign).

Ctrl-O Will display the Open Topic window.

Ctrl-X Will "cut" the messages from the topic and into the computer's clipboard (messages 
remain in the topic). Note: If you "cut" more than one message, all of the messages will 
be combined and placed in the clipboard as one message.

Ctrl-C Will "copy" the messages from the topic and into the computer's clipboard (messages 
remain in the topic). Note: If you "copy" more than one message, all of the messages will 
be combined and placed in the clipboard as one message.

Ctrl-V Will paste the contains of the clipboard (whatever that may be) to a new message and 
place it in the topic.

Ctrl-E Will display the selected message in the Message Edit window.

Ctrl-I Will display the Message Edit window to allow the user to insert a new message. 
Contents of the Message Edit window will be empty.

Ctrl-W Will display the Forward Message window, so that the selected message can be 
forwarded (copy the message from current topic and put to another topic). One or more 
messages can be forwarded.

Ctrl-D Will prompt the user to confirm that you wish to delete the selected message(s). One or 
more messages can be deleted.

Ctrl-F Will display the Find window. The Find window allows the user to search for a text string
that may be contained within one of the messages in the topic.

Ctrl-P Will display the printer selection dialog so that the selected message can be printed.

Ctrl-G Will display the Find window but the search will continue from the previous search 
position.

Ctrl-A Will select (highlight) all messages in the topic.

Ctrl-U Will de-select (un-highlight) all messages in the topic.

F1 Will display MQTT Message Editing Suite's Help system. The Help system provides 
various information about how and what features and functions are available in MQTT 
Message Editing Suite.
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15 Appendix B – MQTT Message Editing Suite Upgrade 
Procedures

To upgrade an existing installation of MQTT Message Editing Suite, please do the following in the 
appropriate section below.

15.1Windows Upgrade
 Stop all instances of  MQTT Message Editing Suite
 Backup any MQTT Message Editing Suite data files in the MQTT Message Editing Suite 

install directory
 Go to the Windows Control Panel and select Program and Features
 Select MQTT Message Editing Suite and then click the Uninstall button
 Run the install program called: mmes-setup-withjre.exe
 The installer follows the standard Windows install procedures and provides default values for 

the user.
 When the install program has completed execution, there will be a newly created folder under 

Start -> All Programs called MQTT Message Editing Suite.
 Restore the MQTT Message Editing Suite data files if necessary
 To run MQTT Message Editing Suite, select the MQTT Message Editing Suite icon from 

within the MQTT Message Editing Suite folder.

15.2Linux Upgrade
 Stop all instances of  MQTT Message Editing Suite
 Backup any MQTT Message Editing Suite data files in the MQTT Message Editing Suite 

install directory
 Next, run the installer with the following command:  ./mmes-setup-trial-linux.bin
 The installer will prompt the user for the installation directory.  The default value will be 

'Capitalware/MMES/'.
 Restore the MQTT Message Editing Suite data files if necessary
 To run MQTT Message Editing Suite, go to the installation directory and issue the following 

command: ./mmes

15.3Max OS X Upgrade
 Stop all instances of  MQTT Message Editing Suite
 Go to the Applications folder and drag the MQTT Message Editing Suite application to the 

Trash
 Double click the MQTT_Message_Editing_Suite.dmg file to open it
 Follow the instructions on the opened DMG window and drag the MQTT Message Editing 

Suite icon to the Applications folder.
 Close the DMG window and then eject the DMG
 To run MQTT Message Editing Suite, go to the Application folder and double click on MQTT 

Message Editing Suite
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16 Appendix C – Frequently Asked Questions (FAQ)

Q. When I click the Test button in the MQTT Broker Profile window, nothing happens. No response 
from MQTT Message Editing Suite at all. 

A. This generally means that the MQTT Message Editing Suite is timing out on a TCP/IP error. The 
TCP/IP time-out value appears to be at least 1 minute (maybe even longer).

Solutions:
• Assuming the network is stable and working, make sure that the MQTT Broker is running on 

the server that you are attempting to connect to.
• The time-out could be from an incorrect value for either the hostname or Port #.

◦ From a Command Prompt or Unix shell, ping the hostname - e.g. ping remotehostname or 
ping xx.xx.xx.xx

Also, verify that you have inputted the same port number that the MQTT Boker is using on the 
remote server.

Q. Can I install MQTT Message Editing Suite on a network drive (LAN) and run it from that 
location?

A. Yes. MQTT Message Editing Suite will happily run from a network drive. Each user's preferences 
will be stored in their own "Settings Directory".

On Windows, the home directory is the %USERPROFILE% folder: 
i.e.
C:\Users\UserID\Capitalware\ 

On Unix and Linux, the home directory is the user's standard logon directory 
i.e.
/export/home/UserID/Capitalware/

Note: If you going to run MQTT Message Editing Suite from a network drive and share it with other 
members of your team, please make sure you have purchased sufficient licenses of MQTT Message 
Editing Suite.

Q. Q. Can I share my MQTT Broker connection information for MQTT Message Editing Suite with 
another user or put it on a network drive (LAN)?

A. Yes. MQTT Message Editing Suite stores the MQTT Broker connection information in a file 
called: BrokerInfo.db. By default, this file is stored in the user's "Settings Directory". You can move 
the BrokerInfo.db to any directory or network drive that you wish.

Q. 

A. 
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17 Appendix D – Support
The support for MQTT Message Editing Suite can be found at the following location:

Online Help Desk Ticketing System at
www.capitalware.com/phpst/

By email at:
support@capitalware.com

By regular mail at:

Capitalware Inc.
Attn: MQTT Message Editing Suite Support
Unit 11, 1673 Richmond Street, PMB524
London, Ontario  Canada
N6G 2N3
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18 Appendix E – Summary of Changes

 MQTT Message Editing Suite v1.1.0
o Added the product version number to the Registration window.
o Added 'Number of threads' for the following MQTT Tool:  Publish Server.
o Added 10 replaceable tokens for the following MQTT Tool:  Publish Server.
o Added right-click menu for selecting the replaceable tokens on the text box for: Publish 

Server.
o Added support for importing COBOL Copybook into the 'Fixed Width' configuration 

window for User Format.
o For CSV, FIX and Fixed Width Viewers, added the ability to click on the column 

header to sort the data by that column.
o For CSV, FIX and Fixed Width layout manager, added 'Type for Table Sorting' column.

It tells MMES how to sort the data in a particular column (i.e. String, Integer, Double, 
etc.).

o Improved the handling of right-click popup menu on the main window
o Fixed issue with preferences being removed when the language is changed.
o Fixed issue with user selected language not being saved as a Preference.
o Fixed an issue with the dock width setting not being removed when the Reset View was

selected (under the View menu item).

 MQTT Message Editing Suite v1.0.0
o Initial release.
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19 Appendix F1 - License Agreement - Unregistered

LIMITED WARRANTY

THE PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER 
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL 
THE AUTHOR OR AUTHORS BE LIABLE TO YOU FOR ANY DAMAGES, INCLUDING 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING OUT OF THE USE OF THE 
PROGRAM, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE, UNDERSTAND IT AND 
AGREE TO BE BOUND BY ITS TERMS AS THE COMPLETE AND EXCLUSIVE STATEMENT 
OF THE AGREEMENT BETWEEN US, SUPERSEDING ANY PROPOSAL OR PRIOR 
AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER COMMUNICATIONS BETWEEN US 
RELATING TO THE SUBJECT MATTER OF THIS LICENSE.

MQTT Message Editing Suite is a shareware program and is provided at no charge to the user for 
evaluation. The purpose of shareware software is to provide personal computer users with quality 
software on a "try before you buy" basis, however payment is still required for continued use of the 
product.

If you find this program useful and continue to use it after a the trial period, you must make a 
registration payment (see the registration instructions for details). This registration fee will license one 
user to use one copy of MQTT Message Editing Suite on any one computer at any one time. All users 
will receive a copy of the latest release when they register, or it will be made available for 
downloading, and free technical support.

Commercial users must register and pay for their copies within 30 days of first use or their license is 
withdrawn.

Anyone distributing this product for any kind of remuneration must first contact Capitalware Inc. for 
authorization.

You may distribute this software to friends and colleagues but you must include all files in the original 
distribution. Please encourage them to register their copy if they find that they make use of it.
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20 Appendix F2 – License Agreement - Registered
This is a legal agreement between you (either an individual or an entity) and Capitalware Inc. By 
opening the sealed software packages (if appropriate) and/or by using the SOFTWARE, you agree to 
be bound by the terms of this Agreement. If you do not agree to the terms of this Agreement, promptly 
return the disk package and accompanying items for a full refund.
SOFTWARE LICENSE

1. GRANT OF LICENSE. This License Agreement (License) permits you to use one copy of the 
software product identified above, which may include user documentation provided in on-line or 
electronic form (SOFTWARE). The SOFTWARE is licensed as a single product, to an individual user,
or group of users for Enterprise License. This Agreement requires that each user of the SOFTWARE 
be Licensed, either individually, or as part of a group. An Enterprise License provides for an unlimited 
number of users to use this SOFTWARE at any time at the specific company. The individual license 
does not provide for concurrent user Licensing. Each user of this SOFTWARE must be covered either 
individually, or as part of a group Enterprise License. The SOFTWARE is in use on a computer when 
it is loaded into the temporary memory (i.e. RAM) or installed into the permanent memory (e.g. hard 
disk) of that computer. This software may be installed on a network provided that appropriate 
restrictions are in place limiting the use to registered users only.  The license, whether individual or 
enterprise, is for a 1-year subscription which includes the latest release of the SOFTWARE and 
support.

2. COPYRIGHT. The SOFTWARE is owned by Capitalware Inc. and is protected by United States Of 
America and Canada copyright laws and international treaty provisions. You may not copy the printed 
materials accompanying the SOFTWARE (if any), nor print copies of any user documentation 
provided in on-line or electronic form. You must not redistribute the registration codes provided, either
on paper, electronically, or as stored in the files MMES.REG, MMES.PROPERTIES, MMES.INI or 
any other form.

3. OTHER RESTRICTIONS. The registration notification provided, showing your authorization code 
and this License is your proof of license to exercise the rights granted herein and must be retained by 
you. You may not rent or lease the SOFTWARE, but you may transfer your rights under this License 
on a permanent basis, provided you transfer this License, the SOFTWARE and all accompanying 
printed materials, retain no copies, and the recipient agrees to the terms of this License. You may not 
reverse engineer, decompile, or disassemble the SOFTWARE, except to the extent the foregoing 
restriction is expressly prohibited by applicable law.

LIMITED WARRANTY

LIMITED WARRANTY. Capitalware Inc. warrants that the SOFTWARE will perform substantially 
in accordance with the accompanying printed material (if any) and on-line documentation for a period 
of 365 days from the date of receipt.

CUSTOMER REMEDIES. Capitalware Inc. entire liability and your exclusive remedy shall be, at 
Capitalware Inc. option, either (a) return of the price paid or (b) repair or replacement of the 
SOFTWARE that does not meet this Limited Warranty and that is returned to Capitalware Inc. with a 
copy of your receipt. This Limited Warranty is void if failure of the SOFTWARE has resulted from 
accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder 
of the original warranty period or thirty (30) days, whichever is longer.
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NO OTHER WARRANTIES. To the maximum extent permitted by applicable law, Capitalware Inc. 
disclaims all other warranties, either express or implied, including but not limited to implied warranties
of merchantability and fitness for a particular purpose, with respect to the SOFTWARE and any 
accompanying written materials.

NO LIABILITY FOR CONSEQUENTIAL DAMAGES. To the maximum extent permitted by 
applicable law, in no event shall Capitalware Inc. be liable for any damages whatsoever (including, 
without limitation, damages for loss of business profits, business interruption, loss of business 
information, or other pecuniary loss) arising out of the use or inability to use the SOFTWARE, even if 
Capitalware Inc. has been advised of the possibility of such damages.
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21 Appendix G – Notices

Trademarks:

AIX, IBM, OS/400, IBM i, IBM MessageSight, IBM MQ, OS/390, WebSphere and z/OS are 
trademarks of International Business Machines Corporation.

Intel is a registered trademark of Intel Corporation.

Java, J2SE, J2EE, Sun and Solaris are trademarks of Oracle Corporation/Sun Microsystems Inc.

Linux is a trademark of Linus Torvalds.

Mac OS X is a trademark of Apple Computer Inc.

Microsoft, Windows, Windows NT, Vista and the Windows logo are trademarks of Microsoft 
Corporation.

UNIX is a registered trademark of the Open Group.
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